PIVOT TABLES FOR CALL
DETAIL RECORDS ANALYSIS




Pivot Tables for Call Detail Record Analysis

Pivot tables are a powerful function built into Microsoft Excel which can be used to translate call detail
records (CDRs) into something useable.

Remember: NEVER WORK WITH YOUR ORIGINAL DATA! You should only use a copy of the files and
not the originals you received from the cellular service provider.
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Step 1-Clean Your Data

In order for a pivot table to work effectively the call detail record data must be standardized. Some
cellular service providers include routing codes, extra digits, and additional information in the same
text box as the phone number. These extra digits will need to be cleaned from the data. You may also
see additional data in the Dialed Number column which does not reflect an actual phone call such as
the case when someone only enters a partial or incomplete phone number before pressing the send
button. As those are not actual calls, but merely records of incomplete calls | delete those records.
Depending on the provider you may also see extra routing numbers or extra digits, such as *67 when
someone blocks their phone number from appearing on caller ID. There are a number of methods for
removing those leading digits including the Find and Select function from the Home tab of Excel.
However, after much trial and error | have become a faithful user of a free suite of tools called ASAP
Utilities. These tools make it very easy to format all of your data quickly.

You may also note that Excel interprets some or all of your data contained in call detail records as text
and not as numbers. When Excel detects numbers stored as text is places a small green triangle in the
upper left of the cell.

You could click on the green triangle and manually change each cell of text into a number but that
would take forever.

Mumber Stored as Text

Convert to Number *

Help on this error

Ignaore Error

Error Checking Options...

To quickly convert all text to numbers highlight the entire column by clicking the cell with a letter in it
at the top of the column. Right click and select Format Cells.
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91073
21092  meen
51092

Clear Contents

51 092 ﬁ' Format Cells...
LColumn Width..,

51092 o
51092  ume

Select Number. By default you will see the number 2 in the box marked Decimal Places. Change that
to 0.

Format Cells

Mumber |.-5.Iignment || Font || Border || Fill || Protection

Category:
General Sample

Other Mumber
Currency

Accounting Decimal ol .
Date Decimal places: ‘_

Time [ Use 1000 Separator ()
Percentage

Fraction Megative numbers:

Scientic Lo —— B

Text 1734

1o
Spedial (1234)

Custom (123

Mumber is used for general display of numbers, Currency and Accounting offer
specialized formatting for monetary value,

QK l [ Cancel
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Step 2-Insert New Columns

If you call detail records do not have a separate column for the target phone number you will need to
create one. The easiest way is to right click you mouse button on the column header A and select
Insert. This will automatically insert a column and shift the data over. In the Al cell type something to
help you remember what this data is such as Target Number. This will be important later as there will
be multiple columns to choose from and you want to make sure you select the proper one.

& | Cut
53 Copy

e

Insert

Delete

Clear Contents
Format Cells...
Calumn Width...
Hide

Unhide

5107308750
5107308750

| 5107308730
r

Insert the target number and then fill the entire column with your target telephone number. The
easiest way to do this is to copy the phone number three times into the first three cells. Then highlight
all three cells by left clicking you mouse button and dragging it downwards until all three cell are
highlighted. If you hover your mouse cursor over the lower right corner of the last cell what looks like a
small plus sign + will appear. Left click the plus sign + and Excel will automatically populate all of the
cells below it with the target number.

You are also going to need to insert another column for your Other Numbers. This data already exists
in the call detail records but some providers display this information in multiple different columns.
Right click you mouse button and select Insert again to place a new blank column in your data and label
it with something you will remember such as Other Number. The other phone numbers need to be
consolidated in one column. Depending on the provider, you may have to sort your data by the
Direction of the call or the Caller ID column to obtain this information. Copy the data from those rows
into your new column so that all of the other phone numbers are in one place.
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Step 3-Finding the Pivot Table

The Pivot Table function is located in two places in Excel. The first in the Insert tab located at the top
of the Excel workbook.

@) 0d9 & ZEE)-

Home Insert Page Layout Formw

o— E”E L3
1] e [P 2
PivotTable Table Picture Clip Shapes Smartart

- _.I],'rt -
Tables Ilustrations

You may also wish to add the Pivot Table to the Quick Access Toolbar located at the upper left corner
of the Excel workbook. In order to add the Pivot Table to the toolbar, select the drop down error to the
right of the toolbar. You will need to select More Commands to locate the Pivot Table function.
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e cut
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Print Preview

More Commands...

Show Below the Ribbaon

S oS W~ oo e =

Next select All Commands and scroll down until you see the Pivot Table Wizard. Select the Add button
to include the Pivot Table Wizard in the toolbar.
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@ Customize the Quick Access Toolbar,

Choose commands from: G

Popular Commands

Popular Commands
Commands Mot in the Ribbon

Macros

Hame Tab
Insert Tab

Page Layout Tab
Farmulas Tak
Data Tab

When you are done you should see this icon in your Quick Launch Toolbar.

H 9 - .1_3]*—'
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Step 4-Using the Pivot Table Wizard

Select Pivot Table from either the Insert Tab or the newly created icon the Quick Launch Toolbar. This
will start the program and automatically bring up this screen:

PivotTable and PivotChart Wizard - Step 1 of 3

Where is the data that you want to analyze?
(*)Microsoft Office Excel list or database!
() External data source
() Multiple consolidation ranges

What kind of report do you want to create?
{(*) PivoiTable
) PivotChart report (with FivotTable report)

We are not going to do anything fancy from this screen so select Next. You could select Finish from this
screen but there are some different options in the following steps.
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The Step 2 screen tells the Pivot Table Wizard where the data is going to come from.

PivotTable and PivotChart Wizard - Step 2 of 3 |E|r5__(|

Where is the data that you want to use?
Range: |m [ Browse,.. ]

[ Cancel ][ = Back ][ Hext = l[ Einish ]

Before selecting next make sure all of the data in your sheet is selected. The data in the sheet should be
surrounded by a moving row of dashes sometimes referred to as ‘marching ants’.

g4
944
941
941
g4
94
Edh
94}
941
94!
941
g4
132}

it

|3 ([ [P R W R U R PN PR PV T PN Y

All of the data inside the highlighted area and surrounded by the marching ants is going to be imported
into the Pivot Table. If for some reason all of the data is not selected, or if the entire work sheet is
highlighted including columns and rows with no data in it, select cancel and click on any cell containing
data on the sheet and re-run the Pivot Table Wizard.

To complete the setup of the Pivot Table select the finish button from the Step 3 screen. By default this
will create the Pivot Table in a new worksheet which will be added in front of your existing worksheets.

PivotTable and PivotChart Wizard - Step 3 of 3

Where do you want to put the PivotTable report?
{(¥) Mew worksheet
() Existing worksheet

Click Finish to create your PivotTable report.

Cancel ][ < Back
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Step 5-Using the Pivot Table

Once the Pivot Table process has been completed you should be presented with the following in a new
sheet added to your Excel workbook:

’EE.D Ho-o-EF30 7 CDT645195_471755_5107308750 [Compatibility Mode] - Microsoft Excel PivotTable Toals
2 Home Insert Page Layout Formulas Data Review View Add-Ins ASAP Utilities Mitro Pro 7 MNuance OCR MNuance PDF ‘ Options Design

PvotTable Name: || Active Field: - ) > on | a === I = [ T

T #Z Expand Entire Field . @ _1;‘ u,\;l/ u,il uj‘ ‘ M 7_1.}' 3 ﬂ

o Options + || @y Fied Settings 2 <0 SR | oo g || B SO Bl Spme Putn | Gl e e [ T o ||t Jeustonshienders

PivotTable Active Field Data Actions Tools Show/Hide
A3 [ A
A C I iPivathble Field List

Choose fields to add to report:
[JTarget

[pate

[]Time

[CIDisled Number
Drop Data Items Here S
[Jother Number
[status
[]5pecial Features
[Jcallertn
[J5witch
[J5ector
[ITower
[J5witch2
[sector2

alaH spleld moy doig

Drag fields between areas below:
W Report Filter A column Labels

il RowLabels

38 -I [ Defer Layout Update
W 4 b ¥i| Sheet2 . CDR Pagel .~ Sheetl . ¥1 !

All of the column headers, including the Target Number and Other Number should appear in the Pivot
Table Field List located in the upper right of the screen. From this screen you can perform basic call
frequency analysis using the data from the call detail records.
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Select Target Number and Other Number by placing a check mark in the boxes. You data may appear in
the boxes labeled Row Labels and Values. If the data is not automatically in those boxes, click and drag
the data so it appears as below:

PivotTable Field List

Chooze fields to add to report:

Target
[oate

[[Time
[ouration

[CJom

[Coialed Mumber
[Joest Number
Other Number
[status
[15pecial Features
[Jcallern
[C15witch
[secter

[rower
[switchz2
[sector2

—.

Drag fields between areas below:
¥ Report Filter FH Column Labels

1] Row Labels T Values

Other Number P Count of Target h -

Sometimes the data in the Values box will be different and will say Sum of Target and not Count of
Target. If this happens you will see strange numbers in the Pivot Table because the software has
decided to add up the total of all of the phone numbers instead of count how often they occur. If that
happens select the drop down menu in Sum of Target.

Drag fields between areas below:
W Report Filter 7 Column Labels

Ha] Row Labels T Values
Other Mumber Sum of Target
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Value Field Settings

Source Name: Target

Custom Mame: |C0unt of Target

Summarize by | Show values as

Summarize value field by

Choose the type of calculation that you want to use to summarize
the data from selected field

Sum -~
E
Average
Iam

Min
Product b

Mumber Format oK l [ Cancel

Once the Value Field Setting has been properly configured you should see each unique phone number

listed with a total representing the number of times the target phone number was in contact with the
other phone number.

A

1 rvln P'ana Eialde Hara

2

3 |Count of Target

4 | Qther Number| =

9258293561

6 (2092715069
2093049451
2093079461
2093493656
2093907769
2094305701
2094825418 b
2094842134
2094850623 4

However, in the example listed above you can see that the first phone number is not listed sequentially.
In this case, the number was not properly formatted and is still viewed by Excel as text and not a

number. If this happens to you go back and reformat the other numbers so they are all represented as a
number.
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Count of Target |
Other Mumber| > |Total
92582035R11 17

20927150 52 Copy

20930494 g_f' Format Cells...

20930794

20934986 (2 Befresh S m—
20939077 Sort

20943057
20948254
20948471 Subtotal "Other Number”
20945508 Expand/Collapse
20956639
20959407
20959430 Ungroup...
20959471
20959473 . .
20960790 Remaoye "Other Mumber
209620348 Field Settings...
20963224
20963950
20964051

Filter

Group...

Mave

PivatTable Optians...
Hide Field List

It is not necessary to re-run the Pivot Table. Select the sheet containing the data and make the
necessary corrections. Then select the drop down box located above the phone numbers and select
Refresh.

If everything looks good, move on to the next step.
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Step 6-Sorting the Numbers

The Pivot Table has given us some good information. You should have a list of unique phone numbers
and a sum of the number of occurances the target was in contact with that number. However, by
default, the Pivot Table is sorted by the phone number and not the total number of contacts. In order to

find the phone number the target was in contact with the most often, we must change the Sort order of
the Pivot Table.

Click the drop down box located at the top of the column and select More Sort Options.

3 |Count of Target
4 |Other Number| =

]| sortAtez

2] | sotztoa

tdore Sort Options... h

Value Filters

(Select All)

In order to see the target number’s most frequent contacts in order, select the Descending option from
the Sort menu and then select Count of Target.

Sort (Other Number)

Sort options

() Manual {you can drag items to rearrange them)
() Ascending (A to Z) by:

{(#) Descending (Z to A) by: ?

Qther Mumber F;
Other Mumber

Count of Target
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This will re-sort the data by the highest number of contacts to the lowest and allow you to easily
visualize the most frequent contacts. Note that the target number will almost always be the largest
number of contacts. Depending on the service provider these calls are actually incoming calls that were
routed to voicemail or they were the user checking their voicemail messages. The next steps are basic
police work-identify the subscribers and users of the high frequency contacts.

iZount of Target
DOther Mumber| = [Tota
5107319368 1632
5105863731 402
6502901549 264
5107308750 235
5105769450 202
5103149041 196
9259612247 191
5103631974 183
5107122982 146
2096322581 142
g250612222 121
2092715069 119
9162844639 118
5106904099 111
5106774697 104
5102274593 100

1
2
3
4
5
G
7
a
9
10
11
12
13
14
15
16
17
18
19
20
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Other Uses For Pivot Tables

Another use for the Pivot Table is basic cell tower analysis. A Pivot Table can quickly and easily add up
the most frequent cell towers which were in communication with the cellular phone. This can provide
clues to a suspect’s location or other areas they are known to frequent. Visualizing cell tower data in a
Pivot Table will require a key from the cellular service provider or from the FBI’'s CALEA
(Communications Assistance to Law Enforcement Act) Unit. However, the basic Pivot Table functions
are essentially identical to those used in determining high frequency contacts.

Follow the steps listed above until the Pivot Table is generated. However, instead of listing the Target
Number and the Other Number you will highlight the Target Number and the Tower. Note that the
provider in this example provides both beginning and ending cell tower data so you may need to run the
Pivot Table on both sets of data in order to get an accurate idea of the location of the handset.

PivotTable Field List v x

Choose fields to add to report:
[¥]Target ~
[[oate i
[Time

[Jburation

[Comr

[Coialed Mumber

[CJDest Number

[Jother Number

[Cstatus

[15pecial Features

[Ccallerio

[Cswitch

[Jsectar

[ Tower _

[CJswitchz

[sectorz

—

By changing the Sort order in a similar fashion to the one illustrated above, you can easily sort the cell
towers by their frequency of use.

Sort (Tower)

Sort options

() Manual {you can drag items to rearrange them)
() Ascending (A to Z) by:

(%) Descending (Z to A) by:

Tower |r w

Tower

‘Count of Target

Sar
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In this example you can see there are only a few towers with a significant number of hits. You might
also note the second most common data point is listed as Blank. This is because the provider from this
example does not record cell tower information when the call is forwarded to voicemail. Most of the
major cellular service providers do not record cell tower information for calls forwarded to voicemail.
Nor do most of the major companies provide cell tower data for text message or data events. However,
AT&T is an exception to that rule as they capture cell tower data during phone calls, text messages, and
data events such as internet browsing.

[Count of Tarng(].

Tower = [Taotal
84 15800
(blank) 1216
587 780
182 726
8 172
452 153
165 141
226 a6
257 90
G0 a0
18 a0
179 76
183
117
53

1
2
3
4
5
3]
T
8
g
10
11
12
13
14
15
16
17
18
19
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